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• 初次使⽤ gretl


• 导⼊外部数据

• 数据分类


• Excel 与 CSV 格式


• 整理数据


• 理解数据


• 如何⾃我提⾼

主要内容
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初次使⽤ gretl



主程序窗
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导⼊内置数据
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导⼊数据后的主程序窗
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变量名称 变量注释



导⼊外部数据



• gretl 可以使⽤多种格式的数据，包括

• CSV (comma separated values file, .csv)


• ACSII (.txt)


• Excel (.xls, .xlsx)


• Stata (.dta)


• Eviews, SPSS, SAS, etc.


• 导⼊数据路径 
 
File > Open data > User file …

导⼊外部数据

8



• 截⾯数据（cross-sectional data）

• 针对不同个体在同⼀时期内收集到的数据。可识别个体  。


• 时间序列数据（time series data）

• 针对同⼀个体在多个时期内收集到的数据。可识别时间  。


• ⾯板数据（panel data）

• 多个个体分别在多个时期内观测到的数据。可识别  。


• 混合截⾯数据（pooled cross sections）

• 跨多个时期的截⾯数据，即在不同时期分别抽样。


• 作⽤：1. 增加样本容量；2. ⽐较不同时期的变化。

i

t

i × t

数据的分类
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Cross-sectional data CHAPTER 1 The Nature of Econometrics and Economic Data 7

unit. Intuition should tell you that, for data such as that in Table 1.1, it does not matter 
which person is labeled as observation 1, which person is called observation 2, and so on. 
The fact that the ordering of the data does not matter for econometric analysis is a key 
feature of cross-sectional data sets obtained from random sampling.

Different variables sometimes correspond to different time periods in cross-sectional 
data sets. For example, to determine the effects of government policies on long-term eco-
nomic growth, economists have studied the relationship between growth in real per capita 
gross domestic product (GDP) over a certain period (say, 1960 to 1985) and variables de-
termined in part by government policy in 1960 (government consumption as a percentage 
of GDP and adult secondary education rates). Such a data set might be represented as in 
Table 1.2, which constitutes part of the data set used in the study of cross-country growth 
rates by De Long and Summers (1991).

The variable gpcrgdp represents average growth in real per capita GDP over the pe-
riod 1960 to 1985. The fact that govcons60 (government consumption as a percentage 
of GDP) and second60 (percentage of adult population with a secondary education) cor-
respond to the year 1960, while gpcrgdp is the average growth over the period from 1960 
to 1985, does not lead to any special problems in treating this information as a cross-
sectional data set. The observations are listed alphabetically by country, but nothing about 
this ordering affects any subsequent analysis.

T A B L E  1 . 2  A Data Set on Economic Growth Rates and Country Characteristics

obsno country gpcrgdp govcons60 second60

1 Argentina 0.89 9 32

2 Austria 3.32 16 50

3 Belgium 2.56 13 69

4 Bolivia 1.24 18 12
. . . . .

. . . . .

. . . . .

61 Zimbabwe 2.30 17 6

TA B L E  1 . 1  A Cross-Sectional Data Set on Wages and Other Individual Characteristics

obsno wage educ exper female married

1  3.10 11 2 1 0

2  3.24 12 22 1 1

3  3.00 11 2 0 0

4  6.00 8 44 0 1

5  5.30 12 7 0 1
. . . . . .

. . . . . .

. . . . . .

525 11.56 16 5 0 1

526  3.50 14 5 1 0
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Time series data

8 CHAPTER 1 The Nature of Econometrics and Economic Data

Time Series Data
A time series data set consists of observations on a variable or several variables over 
time. Examples of time series data include stock prices, money supply, consumer price in-
dex, gross domestic product, annual homicide rates, and automobile sales figures. Because 
past events can influence future events and lags in behavior are prevalent in the social sci-
ences, time is an important dimension in a time series data set. Unlike the arrangement of 
cross-sectional data, the chronological ordering of observations in a time series conveys 
potentially important information.

A key feature of time series data that makes them more difficult to analyze than 
 cross-sectional data is that economic observations can rarely, if ever, be assumed to be 
independent across time. Most economic and other time series are related, often strongly 
related, to their recent histories. For example, knowing something about the gross domes-
tic product from last quarter tells us quite a bit about the likely range of the GDP during 
this quarter, because GDP tends to remain fairly stable from one quarter to the next. Al-
though most econometric procedures can be used with both cross-sectional and time series 
data, more needs to be done in specifying econometric models for time series data before 
standard econometric methods can be justified. In addition, modifications and embellish-
ments to standard econometric techniques have been developed to account for and exploit 
the dependent nature of economic time series and to address other issues, such as the fact 
that some economic variables tend to display clear trends over time.

Another feature of time series data that can require special attention is the data  frequency 
at which the data are collected. In economics, the most common frequencies are daily, 
weekly, monthly, quarterly, and annually. Stock prices are recorded at daily intervals (exclud-
ing  Saturday and Sunday). The money supply in the U.S. economy is reported weekly. Many 
macroeconomic series are tabulated monthly, including inflation and unemployment rates. 
Other macro series are recorded less frequently, such as every three months (every quarter). 
Gross domestic product is an important example of a quarterly series. Other time series, such 
as infant mortality rates for states in the United States, are available only on an annual basis.

Many weekly, monthly, and quarterly economic time series display a strong seasonal 
pattern, which can be an important factor in a time series analysis. For example, monthly 
data on housing starts differ across the months simply due to changing weather conditions. 
We will learn how to deal with seasonal time series in Chapter 10.

Table 1.3 contains a time series data set obtained from an article by Castillo-Freeman 
and Freeman (1992) on minimum wage effects in Puerto Rico. The earliest year in the 

T A B L E  1 . 3  Minimum Wage, Unemployment, and Related Data for Puerto Rico

obsno year avgmin avgcov prunemp prgnp

1 1950 0.20 20.1 15.4 878.7

2 1951 0.21 20.7 16.0 925.0

3 1952 0.23 22.6 14.8 1015.9
. . . . . .

. . . . . .

. . . . . .

37 1986 3.35 58.1 18.9 4281.6

38 1987 3.35 58.2 16.8 4496.7
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Panel (longitudinal) data

10 CHAPTER 1 The Nature of Econometrics and Economic Data

we store the data turns out not to be crucial, keeping track of the year for each observation 
is usually very important. This is why we enter year as a separate variable.

A pooled cross section is analyzed much like a standard cross section, except that 
we often need to account for secular differences in the variables across the time. In fact, 
in  addition to increasing the sample size, the point of a pooled cross-sectional analysis is 
often to see how a key relationship has changed over time.

Panel or Longitudinal Data
A panel data (or longitudinal data) set consists of a time series for each cross-sectional 
member in the data set. As an example, suppose we have wage, education, and employ-
ment history for a set of individuals followed over a ten-year period. Or we might collect 
information, such as investment and financial data, about the same set of firms over a 
five-year time period. Panel data can also be collected on geographical units. For example,  
we can collect data for the same set of counties in the United States on immigration flows, 
tax rates, wage rates, government expenditures, and so on, for the years 1980, 1985,  
and 1990.

The key feature of panel data that distinguishes them from a pooled cross section is 
that the same cross-sectional units (individuals, firms, or counties in the preceding ex-
amples) are followed over a given time period. The data in Table 1.4 are not considered a 
panel data set because the houses sold are likely to be different in 1993 and 1995; if there 
are any duplicates, the number is likely to be so small as to be unimportant. In contrast, 
Table 1.5 contains a two-year panel data set on crime and related statistics for 150 cities in 
the United States.

There are several interesting features in Table 1.5. First, each city has been given a 
number from 1 through 150. Which city we decide to call city 1, city 2, and so on is ir-
relevant. As with a pure cross section, the ordering in the cross section of a panel data set 
does not matter. We could use the city name in place of a number, but it is often useful to 
have both.

T A B L E  1 . 5  A Two-Year Panel Data Set on City Crime Statistics

obsno city year murders population unem police

1 1 1986 5 350000 8.7 440

2 1 1990 8 359200 7.2 471

3 2 1986 2 64300 5.4 75

4 2 1990 1 65100 5.5 75
. . . . . . .

. . . . . . .

. . . . . . .

297 149 1986 10 260700 9.6 286

298 149 1990 6 245000 9.8 334

299 150 1986 25 543000 4.3 520

300 150 1990 32 546200 5.2 493
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Pooled cross sections

 CHAPTER 1 The Nature of Econometrics and Economic Data 9

data set is the first observation, and the most recent year available is the last observation. 
When econometric methods are used to analyze time series data, the data should be stored 
in chronological order.

The variable avgmin refers to the average minimum wage for the year, avgcov is the 
average coverage rate (the percentage of workers covered by the minimum wage law), 
prunemp is the unemployment rate, and prgnp is the gross national product, in millions 
of 1954 dollars. We will use these data later in a time series analysis of the effect of the 
minimum wage on employment.

Pooled Cross Sections
Some data sets have both cross-sectional and time series features. For example, suppose 
that two cross-sectional household surveys are taken in the United States, one in 1985 and 
one in 1990. In 1985, a random sample of households is surveyed for variables such as 
income, savings, family size, and so on. In 1990, a new random sample of households is 
taken using the same survey questions. To increase our sample size, we can form a pooled 
cross section by combining the two years.

Pooling cross sections from different years is often an effective way of analyzing 
the effects of a new government policy. The idea is to collect data from the years before 
and after a key policy change. As an example, consider the following data set on housing 
prices taken in 1993 and 1995, before and after a reduction in property taxes in 1994. Sup-
pose we have data on 250 houses for 1993 and on 270 houses for 1995. One way to store 
such a data set is given in Table 1.4.

Observations 1 through 250 correspond to the houses sold in 1993, and observations 
251 through 520 correspond to the 270 houses sold in 1995. Although the order in which 

T A B L E  1 . 4  Pooled Cross Sections: Two Years of Housing Prices

obsno year hprice proptax sqrft bdrms bthrms

1 1993 85500 42 1600 3 2.0

2 1993 67300 36 1440 3 2.5

3 1993 134000 38 2000 4 2.5
. . . . . .    .

. . . . . .    .

. . . . . .    .

250 1993 243600 41 2600 4 3.0

251 1995 65000 16 1250 2 1.0

252 1995 182400 20 2200 4 2.0

253 1995 97500 15 1540 3 2.0
. . . . . .    .

. . . . . .    .

. . . . . .    .

520 1995 57200 16 1100 2 1.5
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利⽤ Excel 编辑数据
第⼀步：录⼊

14

variable names

optional



利⽤ Excel 编辑数据
第⼆步：导出

15

Excel worksheet

CSV file

在 Excel 单元格中强制换⾏会导致 CSV ⽂件出问题



• 在导出前清除所有格式


• 保存为 unicode (UTF-8) 编码


• 使⽤前⽤任意⽂本编辑软件打开 CSV ⽂件，检查是否有错误

导出 CSV ⽂件时的建议
利⽤ Excel 编辑数据
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• 强烈建议使⽤英⽂输⼊。注意变换输⼊法，避免使⽤全⻆字符。


• 第⼀⾏应为变量名称

• 以字⺟开始，只包含字⺟、数字、下划线。


• 数据排列⽅式

• 每⼀列为⼀个变量，每⼀⾏为⼀个观测值，整体应为⻓⽅形。


• 尽量使⽤数值数据。如原始数据中有字符类分类数据，将其转换为数字。gretl 也会在导
⼊数据时⾃动将字符数据转换成数字。


• 时间数据格式

• 年度数据：4位数字，如 1997


• 季度数据：4位数字 ＋ 分隔符 ＋ 1位数字，如 1997.1, 2002:3, 1947Q1


• ⽉度数据：4位数字 ＋ 点或冒号 ＋ 2位数字，如 1997.01, 2002:10

⽤ CSV 格式保存数据时的注意事项

17



• 在导⼊ gretl 后需要指定数据种类（遵照提示或通过下⾯路径）  
 

Data > Dataset structure …


• 针对⾯板数据，有两种数据保存⽅式

• stacked time series (default)


• stacked cross sections 
 
 
 
 

指定数据的种类

18



• wage.csv 
 
截⾯数据。包含 wage, educ, exper, female, married 五个变
量，其中 female 和 married 为虚拟变量。  
 
包含变量 obsno ，为个体识别编码。


• panel.csv 
 
⾯板数据。包含 state, year, pop, income, tax 五个变量。其中 
state 为个体名称，year 为年份。保存形式为 stacked cross 
sections。

练习⽤数据
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整理数据



• “Setting” — 通过指定数据起点和终点限定数据范围，多⽤于
时间序列数据，其路径为 
 
Sample > Set range …


• “Restricting” — 通过设定逻辑条件限定数据，其路径为 
 
Sample > Restrict, based on criterion …  
 
逻辑条件例：income > 50000, year == 2010, etc. 


• 通过随机抽样选择样本的⼦集

Sample 菜单
限定数据范围
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• 添加⼀个已有变量的对数项或⼆次项，其路径为 
 
Add > Logs of selected variables …  
Add > Squares of selected variables …  

• 添加其他⾮线性项，其路径为 
 
Add > Define new variable …  
 
定义式例：income3 = income^3

Add 菜单
定义新变量

22

新变量名称 新变量定义：income的三次⽅



• gretl ⾃动接受多种形式的缺失值，例如 
 
-999, NA, na, ., 或空缺（即CSV格式中 
两个逗号之间⽆其他字符）


• 也可⼿动指定某些字符为缺失值，其路径为 
 
Variable > Set missing value code…  

• 建议删除包含缺失值的观测值，其路径为 
 
Sample > Drop observations with missing values…  
 

Missing values
缺失值
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添加对数项也可以产⽣缺失值 
（原变量去值为 0 时）



理解数据



• 常⽤描述性统计量： 
 

Summary statistics


• 直⽅图： 
 

Frequency distribution…


• 正态性检验： 
 

Normality test  
Normal Q-Q plot…


• 密度估计： 
 

Estimated density plot…

Variable 菜单
单⼀变量的描述性统计
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• 常⽤描述性统计量： 
 

Summary statistics


• 相关系数矩阵： 
 

Correlation matrix


• 计数（分类数据）： 
 

Cross Tabulation


• 画图： 
 

Graph specified vars >  
Multiple graphs >

View 菜单
多个变量的描述性统计
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如何⾃我提⾼



• 对 gretl 的全⾯介绍： 
 

User’s guide


• 当你进阶到需要编程模式时： 
 

Command reference  
Function reference  
Hansl primer  
（Hansl 是 gretl 内嵌的编程语⾔）


• 不断尝试才能不断进步

Help 菜单
利⽤官⽅资料学习
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• Macro data

• Statistical offices, central banks.


• International and regional organizations: 
IMF, World Bank, OECD, WTO, U.N. Stats Division, EU, NAFTA, Asian 
Development Bank, etc. 


• Micro data

• US: Census Bureau, PSID, etc. 


• Survey data maintained by universities: 
IPUMS, CFPS（中国家庭追踪调查）, CHARLS（中国健康与养⽼追踪调
查）, CHFS（中国家庭⾦融调查）, etc.


• Useful links: 
北京⼤学开放研究数据平台 https://opendata.pku.edu.cn/ 
中国⼈⺠⼤学中国国家调查数据库 http://www.cnsda.org/index.php

Data sources
数据源
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课后练习



• 访问“国家数据”（国家统计局提供）⽹站： 
http://data.stats.gov.cn/index.htm


• 找到下列变量在1990-2020年间的年度数据，并保存到同⼀个 
CSV ⽂件中：


• 年度、国内⽣产总值、居⺠消费价格指数（1990=100）、总⼈⼝、能源消耗
总量、居⺠⼈均可⽀配收⼊


• 注：当有多种变量可选择时，选择你认为最合适的。 
 

	 有些数据可能需要整理或再计算。 
 

	 允许出现缺失值。


• 将你的数据导⼊ gretl ，并了解其特征。

课后练习（不需提交）
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